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Movie Setup:

Note:  Cleanliness is all-important in microscopy!!  Dust and smudges will negatively affect your image quality.  Keep as tidy as possible while in the microscope room.  DON’T GET OIL ON THE 10X OR 40X OBJECTIVES!!!

1) Prepare 1.5% Low-melt agarose (NuSieve GTG) in the appropriate medium for your cells.  For standard movies, use .27 g LMP agarose and 18 mL of SCD (supplemented with extra adenine in ade- strains to prevent background fluorescence; YPD gives high background).  Melt the agarose in a 50mL flask covered with saran wrap using 5-10 sec bursts in the microwave, HIGH setting.  Don’t allow it to bubble over.

2) Let the agarose cool for a few minutes in the microscope room.  While it is cooling, spread a piece of parafilm over a glass plate and place a 24x60mm coverslip on the parafilm for each different medium you are using (usually just one).  After 5 minutes of cooling, use a p-1000 to quickly pipette 2 mL of the agarose onto the coverslip being careful to avoid bubbles.  Quickly and carefully lay a second 24x60mm coverslip over the agarose to create an agarose-coverslip sandwich.  Gently rock the glass plate to level the top coverslip so that the agarose is equally thick at either end.  Let the agarose cool and harden for 15 mins to 1 hour.  While it is cooling, initialize the microscope.

3) If you are using fluorescence, turn on the fluorescence lamp (needs 30 min to warm up).  If the bulb is over 290 hrs, it should be changed.  

4) If a slide remains on the microscope from the previous movie, remove it.  Throw the coverslip into the glass waste and clean the wax off of the edge of the plastic lid using a Kim-wipe, being careful not to smear the top of the lid.  Remove the black, plastic coverslip adapter from the stage.  If there is oil on the 100X objective, clean it with a Q-tip dipped in acetone (repeat 3 times).  ALWAYS BE CAREFUL NOT TO SPREAD OIL AROUND!!

5.1) On the computer, if ImagePro Plus is initialized jump to 6). Otherwise, quit all programs, launch ImagePro Plus (IPP) and click OK when three error messages show up (not critical errors, they only have to do with editing in IPP).  Click on the video-camera icon in the toolbar, it opens the camera control panel.  (Note- this panel is where you can select to acquire 12-bit [standard] or 8-bit images, if you have a problem with your images looking very grainy and dim, make sure the camera hasn’t been switched to 8-bit).  

5.2) Go to Acquire -> Stage-Pro.  If you are asked whether it is ok to switch objectives, hit ok.  The microscope should switch to the 10x objective.  If it does not, you should change objective manually. A warning appears telling you to make sure the objectives are out of the way.  Move the 10x objective all the way down using the lower black button directly behind the right focus knob on the side of the microscope.  Hold the button until the objective stops moving down. Then hit close.

5.3) In the next window, select “Use physical limits of stage” and don’t change any other selections.  Hit ok.  Another warning appears.  Make sure the objective is all the way down and hit ok.  The stage will begin to move from corner to corner to initialize itself (necessary so the computer can keep track of positions in x,y).  Once it’s done, a message appears telling you that it wants to move back to the 100X, click ok.  The stage control panel appears which can be minimized (look here for the number of pixels per micron if you need this info, it’s about ~11 pixels/micron).  Move the 100X objective all the way down again.  [Possible error:  the stage might stop moving during initialization and an error message might appear.  If this happens, click ok on the error message and then close the stage control panel that appears.  Turn the stage controller (the silver box just to the right of the air table) off and back on.  Go back to Acquire -> Stage-Pro, and repeat initialization.]

6) Open MelowCommander_StandardVersion.exe, icon should be located in the upper left corner of the desktop.  It should open two panels:  MelowSnapper and Melowitz Shutter Commander.  If it doesn’t open both, quit the program then hit Ctrl-Alt-Del to open the Windows Task Manager.  “End Task” for all visual basic programs.  Repeat step 6.

7) Make a directory for your data on the appropriate drive.  Name the directory by the date (yymmdd).

8) To set standard timelapse parameters for GFP (1.5 sec GFP exposure, gain = 50,  .1 sec phase exposure at 5.5 Amp using TX2 filter, 3 min intervals, 240 frames), hit “Jamie’s Settings” on MelowSnapper or specify your own fluorescence and phase settings. (Note:  while filter wheel is still sticking, need to switch Phase Parameters: Color: to Cube 2(gfp) and Lamp Intensity: to 7. Note:  assumes you are using GFP for fluorescence and are using Neutral Density Filter NDD 2 for 1% fluor transmission)

9) Hit “Time Lapse / Autofocus” button on Melowsnapper to open Melow time-lapse setup panel.  Hit “Base path” button and specify the directory you have created for your movie.  For Base Filename, use the date (yymmdd).  In this panel you can specify number of frames, interval between frames, and autofocusing parameters.  If you know you don’t need a full 12-hour movie, reduce the number of frames from 240 to save space and time.

10) Hit “Positions...” button on Melow time-lapse setup to open MelowStage: Positions panel.  This panel is used to record the position of different cells on your slide.

11) Re-attach the black plastic coverslip adapter to the stage and secure it with the metal arms.  The microscope is not ready for your cells.

12) Sonicate your cells.  Use a scalpel to pry the top coverslip off of the hardened agar slab.  The slab usually sticks to the bottom coverslip but it if comes off with the top one, just invert it and lay it back down on the parafilm (coverslip side down).  Trim about 2mm off of 2 edges of the agar slab.  Cut the slab into rectangles about 5-7 mm wide by 10-14 mm high.  Cut as many pieces as you have strains/conditions (max of 4).  Place a clean 24x60 mm coverslip on a second piece parafilm on glass.  Add ~1.5 µL of cells to the first agar slab piece and flip the piece on to the clean 24x60mm coverslip using the scalpel.  Wipe off the scalpel with a Kim-wipe and then repeat with the other samples.  Arrange the agar pieces in pairs such that two pieces can be covered by one 18x18mm coverslip.  Avoid placing the agar slabs near the left and right edges of the coverslip, as this will cause problems with the objective later.  Cover the 18x18mm coverslip(s) with a clear plastic lid (Lab Tek Chambered Coverglass System).  Use Paraffin wax to attach the lid to the 24x60mm coverslip making sure the lid does not overhang the edge of the coverslip (See figure). 
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13) Add a SMALL drop of oil (~5mm diameter) to the BOTTOM of the coverslip below each agar slab.  Place the coverslip on the plastic adapter above the 100x objective.  Move the stage using the joystick to line up your first sample with the objective.  Begin to move the objective up towards your sample using the focus knob and look for contact with the oil.  Hit “Open Trans Shutter” on Melowitz Shutter Commander.  Begin looking for your cells.  MAKE SURE THE LIGHT IS SWITCHED TO THE VIS PORT ON THE FRONT OF THE MICROSCOPE!  

Finding cells can be very tricky and time consuming and often requires opening the field diaphragm all the way to let more light in. Once you find your cells (i.e. specimen plane) with the objective, you MUST align the condensing lens with it (set Koehler illumination).  This requires closing the field diaphragm as far as possible, and focusing the condenser (silver knob on left of condenser) until the edges of the diaphragm can be seen clearly and are centered (you should see your cells through a septagon of light).  Then open the field diaphragm just enough to see the whole field.

14) Find a suitable field of cells using the joystick and focus using the focus knob.  You can adjust how course or fine the focus knob is by using the STEP button on the front of the microscope (normally leave it at the finest setting, S0). (Three cells in an equilateral triangle near the center works well, just make sure they have enough space to go through several cycles.)  On MelowStage: Positions, click “Get Current” and then “Add to List” to record that position in x,y,z.  Move on and record up to a limit of 4 positions (assuming 3 minute intervals).  Once you have recorded all your positions it is useful to go back to each by double-clicking on the Position List in MelowStage: Positions to check for any drift.  Re-adjust focus and centering, hit “Get Current” again, then hit “Replace”.  It will ask you if you want to replace the selected position, click Yes.  Repeat for all your positions.

15) Go through the last minute checklist on the front of the Leica controller.  Switch back to the side port, make sure the fluorescence bulb is on, close the incubation chamber doors, close the window shade, turn off the overhead lights, and make sure the oil bottle is capped.  Pick up any mess you’ve made before you start the movie.

16) Hit the “Start” button on Melow time-lapse setup.  Watch the first round of image acquisition to make sure the autofocusing is working properly.  If not, hit “Stop” on Melow time-lapse setup (once the first round is completed; you can’t stop it while it is running).  Use the stored positions to go back to the out-of-focus cells, re-focus, and update the positions as in step 14, as necessary.  Hit “Start from t=0” button on Melow time-lapse setup to let the program resume.  Once it goes through a round with everything in focus, cover the screen with aluminum foil (on shelf) and leave.  Put “Movie in Progress” sign on door.

17) After the movie finishes, remove the coverslip from the adapter. Throw the coverslip into the glass waste and clean the wax off of the edge of the plastic lid using a Kim-wipe, being careful not to smear the top of the lid.  Remove the black, plastic coverslip adapter from the stage.  Clean the oil on the 100X objective with a Q-tip dipped in acetone (repeat 3 times).  ALWAYS BE CAREFUL NOT TO SPREAD OIL AROUND!!  Hit “Quit” button on Melowsnapper but leave ImagePro Plus on.  If nobody else has signed up to use the microscope after you, turn off the fluorescence lamp.  Remove your tubes and trash from the microscope room.

Movie Compression, Segmentation, and Annotation:

Note:  This guide assumes that you are able to connect to the microscope computer through the network and are using one of the analysis computers in the library.  For networking problems or to set up a new computer on the network contact IT.

Note:  The computer being used must have MatLab installed with the following toolboxes:  curvefit, images, stats.  For this guide it is assumed to be MatLab version 7.0.4.  Cygwin (or some other unix shell utility) must be installed also.

Note:  Each user should establish his own directory in the MatLab work directory (C:\work on FCROSS-MATLAB1 (right library computer); C:\MATLAB704\work or C:\MATLAB7\work on FCROSS-SCOPE-2 (left library computer).  Within each user’s work directory should be a folder called yeast_tree10.  This is the latest version of the segmenter and annotation tool.  Within yeast_tree10 is yeast_tree1.5 (the actual yeast_tree directory) and within that is ‘starter_proj’ which contains all the required directories for the segmentation and annotation software.  yeast_tree10 can be copied from C:\work\jamie.  Check the HOWTO and README files in the yeast_tree directory for more information on how these scripts work.  

Note:  It is important to add any new directories you create into the MatLab path (launch MatLab -> File -> Set Path -> Add with Subfolders, then select your MatLab work folder -> click OK) 

Note:  Occasional errors in MatLab can often be resolved either by typing ‘clear all’ in the command window or by quitting MatLab and restarting it.  It’s unclear what some of these issues are but they may have to do with MatLab not completely clearing its cache and releasing files for use by other scripts.  It’s also possible to get into a fatal state while using “yeast_tree”, the annotation tool.  In some cases, quitting MatLab and restarting it and “yeast_tree” will resolve these issues but in other cases, you will need to remove all the files from the sub-directories in your project directory that are created by yeast_tree and start the annotation over (leave everything in the raw_* directories, i.e. all the .jpegs and the “list” files, but remove everything else that wasn’t in the project directory from the start).

Note:  This guide assumes that you are working on one of the Cross Lab PCs in the library.  Some changes will be necessary if working on other platforms or computers.

1) Navigate to C:\work\your MatLab directory\.  Copy ‘starter_proj’ from wherever you keep it and rename the copy using the following convention:  for controls and Wt strains the name must begin WTyymmdd; for mutant strains (or whatever you want to compare to your control), names must begin MTyymmdd.  For example, WT051225-01, would be a Wt/control movie from Dec. 25, 2005 that was in the first position during acquisition of the images.  MT051225-02swi4, would be a mutant (swi4 in this case) from the same movie (assuming only one movie from the same date) in the second position.  It is useful to keep the position number and strain genotype in the name so that you can identify which is which.  The first 2 letters and 6 digits must follow these conventions if you want to use the movie analysis scripts later on for plotting histograms of CLN2pr-GFP peaks, bud-to-peak times, and size at budding and to normalize across dates using Wt controls from different dates.  Look in C:\work\jamie for examples.

Once you have renamed the “proj_dir copy” with an appropriate name you can copy your images across the network into the appropriate directories. 

2) Go to Start -> My Network Places -> Guest Documents on F. Cross Microscope (Fcross-scope).  Navigate to your movie directory.  Copy all the fluorescence images from one position (yymmdd-position#-g-frame#.tif, if a gfp movie) to your renamed proj_dir\raw_fluorescent.  Copy all the phase images from the same position (yymmdd-position#-p-frame#.tif) to your renamed proj_dir\raw_phase.

3) Launch Cygwin Bash Shell.  At $ prompt type ‘cd C:/work/your MatLab directory/ your project directory/raw_fluorescent/’ (or, navigate to your raw_fluorescent directory using whatever path you need).

At $ prompt type ‘ls –1 *.tif > list’ (this creates a file named “list” that contains the names of all the .tif files in the raw_fluorescent directory).

Use the cd command to move to the raw_phase directory and repeat.  The segmenter and annotation programs need these “list” files in order to work.  However you can create a file called “list” with all the .tif file names listed in order is fine.

4) Launch MatLab 7.0.4.  In the Current Directory window, navigate to the yeast_tree1.5 directory in your work directory.  In the Command Window, type ‘compressTifs’.  A window appears in which you can browse for your project directory.  Select your project directory.  Click OK.  The compression will begin and will create much smaller .jpeg’s of all the .tifs.  It will take around 40 mins depending on how long your movie is.  Ignore any error message that appears at the very end about logfiles.

5) Quit MatLab after it finishes compression.  It’s a stupid MatLab bug.  MatLab won’t let you remove the .tifs or create a new list file so you have to quit MatLab.  In the Cygwin window you should still be in the raw_phase directory.  At the $ prompt type ‘rm *.tif’, enter, ‘rm list’, enter, to remove all the .tifs and the old “list”, then type  ‘ls –1 *.jpeg > list’ to create a new “list” file with all the .jpeg’s.  Repeat in the raw_fluorescent directory.  Quit Cygwin.

6) ) Launch MatLab 7.0.4.  In the Current Directory window, navigate to the yeast_tree1.5 directory in your work directory.  In the Command Window, type ‘generateLayers’.  A window appears in which you can browse for your project directory.  Select your project directory.  Click OK.  Follow the onscreen instructions for drawing a boundary around one colony/founder cell.  It is often helpful to only deal with one cluster of cells at a time and it is much faster.  It’s also useful to include some information about which particular cluster in a movie is being segmented in the project directory name (i.e. 051225-02swi4-LL, for the lower left cluster from the swi4 movie at position 2 on Dec. 25, 2005) before you begin segmentation as the name of the project directory will appear in the name of the exported files at the end.  This begins the segmentation, which takes 15-20 mins.  Ignore any error message that appears at the very end about logfiles.  

Note: if you get an error during segmentation about failing to find a plateau, check the image in question to make sure it looks ok; if it is a bad image (all black or corrupted) make a copy of the previous image and rename it (both phase and fluor)to the current image.  (i.e. if image #12 is bad and causes segmentation to crash, try copying image #11 and renaming the copy image #12).  This will only work if you have only a few bad images and they are not one after the other.  

Note:  there is a known bug that prevents you from drawing a boundary in generateLayers if you have previously run generateLayers in the same MatLab session.  In this case, as soon as you try to draw the boundary the segmenter begins.  This won’t be a problem after you have quit and restarted MatLab in step 5.

Note:  Using a mask in generateLayers creates a file in the project directory called “maskStructure_#####.mat”.  This mask file is also stored in the yeast_tree1.5 directory and called “savedImageMask.mat”, but it is over-written each time you use a mask  and run generateLayers.  If you want to come back to a project directory you have previously run generateLayers with a mask on, you must copy “maskStructure_#####.mat” from that project directory to the yeast_tree1.5 directory and rename it “savedImageMask.mat”.

The segmenter will populate “cellbodies\”, “viewable_fluorescent\”, and “viewable_phase\” in your project directory with .tif files and “celllabels\” with .mat files.

7) Quit and restart MatLab after it finishes segmentation.  Navigate back to yeast_tree1.5 and type ‘yeast_tree’ in the command window.  You’ll see the same window browser, select your project directory and hit OK.  This will open the yeast_tree annotation window.  For details on how it works, see the HOWTO and README files in the yeast_tree1.5 directory.  To select a cell, click on it (it turns yellow).  You must set “Bud Time” for the founder cell to begin annotation (this initial bud time is artificial).  Newly identified cells (including the founder cell(s)) are hatched, once they are annotated the hatches disappear.  Setting a bud time, turns the cell label blue.  To connect a budded mother cell to its daughter cell, select the mother, hit “Connect”, then select the daughter.  You can’t connect a cell that does not have bud time (i.e. isn’t blue).  To specify division time after connect a mother and daughter, select the mother then hit “Sep. Time”.  Separating mother and daughter turns the mother label back to red and it becomes eligible for a new “Bud time”.  You advance through frames using the “Next” button, and back using the “Prev” button.  “Jump To Frame” allows you to specify a frame number to go to but you cannot annotate more than one frame away from the last annotated frame (i.e. you can’t skip ahead in the annotation).  To remove a false cell identified by the segmenter, select it and hit “Delete Cell Body”.  To replace a cell that the segmenter lost, hit “Draw Cell Body” then specify the 4 points of the ellipse.  Yeast_tree will not allow you to proceed until all lost cells have been replaced.  You can delete new cells (hatched ones) without any problem, but once you annotate them (connecting them to a mother) you cannot delete them and proceed without replacing them.  RULE:  CELLS DO NOT DISAPPEAR!!!  You can remove incorrect connections by using the “Disconnect” button (supposedly, although I have often run into problems using this feature.  I recommend being careful with you connections and not relying on the “Disconnect” feature at all.)  The buttons on the far right allow you to toggle different layers on/off.  It’s often useful to turn the “flourescent” layer off in order to score bud emergence if you don’t have a fluorescent marker for budding (i.e. Myo1-GFP or Cdc10-GFP)..  

Note:  the program gives error messages that guide you along the way and prevent you from doing things incorrectly, however, it is possible to get stuck in such a way that you cannot proceed.  See the general note above on these situations.

Another (sometimes) useful feature is ‘Edit -> Clear Annotations for cell’, which allows you to correct any mistakes you made for a particular cell.  However, I have found this feature to be very tricky as it sometimes forces you to start unraveling the whole annotation back to the beginning.  It is best used immediately after a mistake is made (before advancing the frame) for a cell without many connections.  If you are near the very end of a long movie, it is better not to risk complications with this and to simply proceed to exporting the data rather than trying to correct a small error in the last frames.

8) When you are finished (due to end of movie or too much crowding) go to ‘File -> Export’.  This exports the data from the annotation into several files, all of which are created in your project directory and whose names begin with your project directory name:  

 “your project directory_biocell_founder_#.txt” – shows when each cell is connected to and divides from other cells using the cell labels


 “your project directory_budtimes_founder_#.txt” – for all cell labels gives a ‘1’ in each frame in which that cell buds, ‘0’ in all other frames


 “your project directory_divisions_founder_#.txt” – uses the ‘old’ paper method for specifying cells in a pedigree (1=daughter, 0=mother), gives summary data for the whole pedigree


 “your project directory_fluorescence_founder_#.txt” – gives the average pixel intensity for each cell at each frame (all 0’s before a cell is identified)


 “your project directory_sizes_founder_#.txt” – gives the size in square pixels for each cell at each frame (all 0’s before a cell is identified)

The “#” in the names refers to the cell label for the founder cell for that cell cluster (usually “1” or “2”).

The ‘budtimes’, ‘fluorescence’, and ‘sizes’ files are all ‘cell-labels x frames’ matrices.  They are best viewed with Excel and can be used to plot graphs directly from them.  These exported files are also used in the next step, the data analysis program.

CLN2pr-GFP Movie Data Analysis:
Note:  this program was designed to allow normalization and quantitation of CLN2pr-GFP and bud emergence timing of many movies across many different dates using the exported files from yeast_tree.  It corrects for the varying brightness of the fluorescence bulb from day to day.  To work, the program requires the ‘WTyymmdd’ and ‘MTyymmdd’ convention be used.  All ‘WT’ labeled movies are assumed to be the same control (not necessarily the same strain) and are used to generate correction factors for each date.  ‘MT’ movies are then normalized using the correction factors from their respective dates.  ‘MT’ movies for which there is no matching ‘WT’ movie of the same date can be given user-provided correction factors based on other correction factors from similar dates or can be left out of the analysis.

Note:  you can only compare one mutant/condition to the Wt/control per run of the program.  The program will not distinguish between different ‘MT’ files in the same directory (i.e. 

‘MT051225-02swi4-LL’ and ‘MT051225-04mbp1-UR’ would be lumped together as ‘mutant’ for the analysis).

Note:  see the comments in the various scripts in ...\bud_CLN2-GFP-peak_scripts\051216 for descriptions of how the program works.  In general the analysis is conservative in assigning CLN2pr-GFP peak amplitude and assigning bud-to-peaks.  This results in smaller overall numbers of data points, but what is counted can be believed to be accurate.

Note:  users should copy into their MatLab work directory the bud_CLN2-GFP-peak scripts and should add it to the MatLab path (see above).  Copy from C:\work\jamie\bud_CLN2-GFP-peak_scripts\051216 on FCROSS-MATLAB1 (right library computer).  This is the certified version of the program.

Note:  this guide assumes you are using FCROSS-MATLAB1, if not adjust accordingly.

1) In your MatLab work directory, create a folder for each mutant/experimental condition you want to compare to a Wt/control and name the folder appropriately (see C:\work\jamie\annotations for examples).  

2) Copy ALL the yeast_tree export files (5 files for each founder cell annotated) for ALL movies of that mutant/condition (MT) into its respective folder, along with ALL the export files for ALL the corresponding Wt files (WT).  WT files for which there are no corresponding MT files of the same date are fine.  They will still be counted in the analysis of the Wt.  MT files with no corresponding WT file cannot be automatically corrected and can either be left out of the analysis or can use a user-supplied correction factor (user will be prompted for this when the analysis program is started).

3) Copy the full path from the Address bar in the Windows explorer window of the mutant directory you just filled. 

(ex. ‘C:\work\jamie\annotations\haploids\MTswi4_+Met_CLN2pr-GFP’)

4) Launch MatLab 7.0.4 and navigate through the Current Directory window to your ...\bud_CLN2-GFP-peak_scripts\051216 directory.  Open ‘bud_CLN2_GFP_peak.m’ in the MatLab editor by double-clicking on ‘bud_CLN2_GFP_peak.m’ in the Current Directory window.

5) Scroll down to line 61 and paste the full path of the mutant directory into the single quotes on the line to assign it to the global variable ‘proj_dir’

( ex. proj_dir = ‘C:\work\jamie\annotations\haploids\MTswi4_+Met_CLN2pr-GFP’; )

6) Save your changes to ‘bud_CLN2_GFP_peak.m’.

7) In the MatLab Command Window, type “bud_CLN2_GFP_peak”, enter.  If there are any MT files for which it cannot calculate correction factors, it will show all the correction factors for the dates it could calculate and ask if you want to assign a correction factor for the missing date(s).  It will then proceed through the analysis.

During the analysis, it displays the spline fits for the CLN2pr-GFP peaks and the bud-to-peak associations for each cell in each movie, starting with WT and ending with MT.  It also shows the standardized CLN2pr-GFP peak pairs for WT and MT.  The program takes a minute or less to run and outputs 24 more MatLab figures (none of which are automatically saved but can be saved and edited using the File and Edit menus on each figure).  

The program returns 20 histograms, 4 scatter plots, and 2 line graphs, all of which can be saved and/or printed.

All the histograms display mean, standard deviation, and number (n) for both the full data set and a trimmed data set that tosses out any points outside of 3 standard deviations from the full data set mean and then recalculates mean, standard deviation, and number.

The histograms are:

Cell size at budding, WT  (all cells)

Cell size at budding, MT  (all cells)

Cell size at first budding, WT  (first-time mothers)

Cell size at first budding, MT  (first-time mothers)

MB1-MB2, WT  (bud-to-bud interval, experienced mothers)

MB1-MB2, MT  (bud-to-bud interval, experienced mothers)

MB1-DB1, WT  (bud-to-bud interval, first-time mothers)

MB1-DB1, MT  (bud-to-bud interval, first-time mothers)

CLN2-GFP peak amplitudes, WT

CLN2-GFP peak amplitudes, MT

CLN2-GFP peak amplitudes, mothers, WT

CLN2-GFP peak amplitudes, mothers, MT

CLN2-GFP peak amplitudes, daughters, WT

CLN2-GFP peak amplitudes, daughters, MT

Budding to CLN2-GFP peak, WT

Budding to CLN2-GFP peak, MT

Budding to CLN2-GFP peak, mothers, WT

Budding to CLN2-GFP peak, mothers, MT

Budding to CLN2-GFP peak, daughters, WT

Budding to CLN2-GFP peak, daughters, MT

All the scatter plots report numbers (n) for both WT and MT.  The scatter plots are:

MB1-MB2 vs. Standardized GFP peak amplitude, in WT and MT

MB1-DB1 vs. Standardized GFP peak amplitude, in WT and MT

Size at budding, all mothers vs. Standardized GFP peak amplitude, in WT and MT

Size at budding, first-time mothers vs. Standardized GFP peak amplitude, in WT and MT

The line graphs give the numbers (n).  They are:

Standardized GFP peak pairs, WT

Standardized GFP peak pairs, MT
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